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Dante Advanced Configuration

Networking Matters

ADante’

DIGITAL MEDIA NETWORKING PERFECTED
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Dante: Advanced
= Contents:

= Clock

= |Latency

= Bit Depth

= Sample Rate

" Flows

= QoS

= |GMP Snooping

= VLANS, LAGs & STP

= Switches & Cables
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Dante: Clock

= Does not use TDM
= Time Division Multiplexing
= Used by traditional digital audio transports
* Such as AES/EBU, MADI, EtherSound
= Each audio channel sends data during a set time interval
= Clock signal is derived from the timing of the audio data

Word Clock  — / \
TDM Slots [ X2 X3 X 4 X5 X6 X7 X8 X9 X10 X1 X12 X1z X114 X15 X1 X

= But these are systems with a fixed-capacity...
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Dante: Clock
= Dante Clock Is Packet Based

IP Header Data

= Using PTP: Precision Time Protocol
= |[EEE1588
= Sub-microsecond accuracy
= PTP is used in extremely time critical applications

* Factory Automation
* Wall street trading
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Dante: Clock - PTP
= |t is a Master / Slave concept
= With strictly one Master only

" The Master is automatically selected based on:

e Y W Master Clock: Y001-Yamaha-CL5-060ba6 Multicast Bandwidth: 0 bps ?)
[Routing = Device Status - Clock Status | Events |

Device Primary Interface Secondary Interface Clock Slave To External

Name Clock Status Clock Status Role Word Clock
CaSCoaCDOOR TrStenmy A Telenleisieieigucie; Stave ony N TewnIeiesie guaie)
Y001-Yamaha-CL5-060ba6 Master Link down [ﬂ Preferred Master @ Yes I
wiG Gl amabeniiotlidebebGitonmb isievions) nfreferredsiinre b
Y002-Yamaha-CL3-06167a Slave Link down # Preferred Master [ Yes
Y002-Yamaha-Rio3224-D-060da2 Slave Link down [_] Preferred Master Not Supported
Y003-Yamaha-Rio1608-D-06218c Slave Link down [ Preferred Master Not Supported
Y004-Yamaha-Ri8-D-068648 Slave Link down [_] preferred Master Not Su rte
Y005-Yamaha-Ro8-D-0687a8 Slave Link down [ Preferred Master Not Supported

s it labelled as “Preferred”?

s it slaved to “External Clock”?

Does the Dante module have a high quality clock?
Is its MAC address lower than other devices?

s w e
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Dante: Clock - PTP

= After a Master device is selected, it will start to
multicast transmit a discipline signal to each slave, to
keep them in sync.
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Dante: Clock - PTP

= Each slave will determine its time offset caused by
transmission delay.

= The slave sends a “Delay Request” to its Master
= The Master replies with a time-stamped “Delay Response”

-

message . )
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Dante: Clock - PTP

= The Slave will perfectly time-align itself to the Master
= And all Slaves will be perfectly in sync

= The sync is checked several times every second
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Dante: Clock - PTP

= |f the Master clock gets disconnected...
= Al| slaves will continue to run from their own clocks

= A new Master is elected quickly and automatically
= Everything syncs again, with no silence and no glitch!
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Dante: Clock - Network Clock Comparison
* How good are conventional networks at
synchronising Clocks?

= Add an extra switch: what happens to the sync?

> Oscilloscope €

Ethersound

oY 5 il SET RN I ut:‘ ‘.‘,ﬁ!’,‘ |
- e maror] | -5
O i CobraNet
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Dante: Clock - Delay in a Network

= The “Control” of the experiment: Both mixers clock
to Ext. Gen.

Tek  .Jl. Trig'd

" |n sync and in phase r -

M Pos: =10.00 s TRIGGER
v

Type
l -

Source
CH1

Slope
Rising

Mode
Normal

Coupling

CH2 1.00% M 2,50 us
T-May-13 16:38
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Dante: Clock - Delay in a Network
= The Master Mixer clocks
internally, Slave Mixer

clocks via AES/EBU.

Tek Al Trig"d M Pos: =10.00 s TRIGGER
A 4

Type
v s

= |n sync, but not in-phase ‘ ]

CH1

= (Slave = blue) ke L

- Rising

Mode
Normal

Coupling
CH2 1.00% M 25008
T-May-13 16:40
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Dante: Clock - Delay in a Network
= Slave Mixer clocks via
CobraNet.

Tek T Tria’d M Pos: =10.,00,us TRIGGER
v

| Type

Source

" |n sync but not in phase Ch
Sope
= (Slave =blue) L amas o

Mode
Normal

Coupling
CH2 1.00% M 2,50 s
T-May-13 17:23
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Dante: Clock - Delay in a Network
= Slave Mixer clocks via
CobraNet.

= Add another switch to the T1ex

L Trig"d
network

M Pos: =10.00 s TRIGGER
A 4

| Type
\——‘ [ s =

Se

= Clock phase shifts dueto \ B Shope

extra signal delay s

Norrnal

- (Slave = blue) Coupling
CH2 1.00Y M 2,50, us

-May-13 17.27
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Dante: Clock - Delay in a Network
= Slave Mixer clocks via

Dante.
Tek S Trig'd M Pos: =10,00 s TRIGGER
Y T')"D
= See the clocks slowly | -
S
converge il
= Time-aligned within o] T i
a bout O_ 1”5 Tek .M. @Tigd M Pos: 0,000 TRIGGER ' r-r,|
TLW . '
= (Slave = blue) | Comin

CH2 1.00v M 500ns
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Dante: Clock - Delay in a Network
= Slave Mixer clocks via Dante.

= Add another switch to the network

Tek S Trig’d M Pos: -1 0.02»5 TRIGGER
Type
= |f clock drifted away, - ' *‘\ -
. . . . | $
it will drift back into Cil
phase again within o] i S
a few seconds. e
= Because Dante clock Couping
- .
is time-stamped. i v M 28008

7-May-13 1753
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Dante: Clock - PTP

= The sync tolerance of Dante devices is guaranteed to
be +/-1us (microsecond)
* |n practice we find it to be more like +/-0.2us
" One clock cycle at 48kHz is 20.8us
= So we have a realistic sync within 1/100t" of a sample!

= All outputs from the -~
. . Tek S Trig’d . M Pos: —=1.600us DISPLAY
network will be w/c aligned!
Persist

|

|

|
:’—_—L_—
Tyt et

CH2 2.00% M 5.00us
23-hpr-13 15:32
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Dante: Advanced
= Contents:

= Clock

= Latency

= Bit Depth

= Sample Rate

" Flows

= QoS

= |GMP Snooping

= VLANS, LAGs & STP

= Switches & Cables
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Dante: Latency
= Data takes more time to travel through a switch than
through a wire

= The switch analyses, copies, filters, splits, forwards the
data...

= So more switches in a network means more latency
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Dante: Latency

= Some Dante devices have switches built in to allow
for simple “daisy-chain” connections

= Most Dante devices have a fixed number of latency
options, to keep it simple.

= Latency general rule; 100 microseconds per switch

~Device Latency

Current latency: 0.5 msec
Latency Maximum Network Size
0.15 msec Cigabit network with one switch
() 0.25 msec Gigabit network with three switches
® 0.5 msec Gigabit network with five switches
() 1L.0msec Gigabit network with ten switches or gigabit network with 100Mbps leaf nod
() 2.0 msec Gigabit network with 100Mbps leaf nodes

() 5.0 msec Safe value
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Dante: Latency
= Star, 4 Dante devices

= Audio travels through 3 switches
= Use 0.25ms setting (or higher)
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Dante: Latency
= Star, 5 Dante devices + 2 switches

= Audio travels through 4 switches
= Use 0.5ms setting (or higher)
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Dante: Latency

" Or, to keep in-ear monitoring latency low, set
Monitor console and Rios on stage at 0.25ms

= Set FOH console at 0.5ms
= Different latencies can co-exist!f \

A R Al e e e B
htt:/l\_ 12 I —
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Dante: Latency
= Latency comparison:

= Yellow = mic->omni in->omni out (no Dante)

= Blue = mic->Rio->CL@Mons->Rio (0.25ms latency)
* Pink = mic->Rio->CL@FOH->Rio (0.5ms latency)

Tek e M Pos: -1.000ms  TRIGGER
v

Type

4
Source
/, ,\

N
— Slope
. : Rising
. Pink  =3.0ms -\

Mode

Normal

Coupling

M 1.00ms CH2 7 152mVY
24-Apr=13 10:22 <10Hz

CH2 200mY
http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: Latency - Guidelines
= |f the transmitting device and the receiving device
nave different latency settings, the higher setting will

pe used.
= Multicast transmission will ALWAYS have a latency of

1ms, regardless of the setting.

= Switches often take more time to analyse and forward
multicast data, so Dante needs to compensate.

= 1ms setting can cover a network 10 switches wide.

= 5.0ms setting is just for troubleshooting and should
never be necessary.

25
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Dante: Latency
= What happens if you set the latency too low?

= Don’t worry, if you follow the above guidelines, you will be
safe: there is plenty of “safety margin”.

= |n lab conditions, 10 switch hops can work with 0.25ms
latency (very well tuned network)!

= Using QoS helps to achieve low latency

= (More info later)
= |If latency really is set too low, there will be silence...
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Dante: Advanced
= Contents:

= Clock

= |Latency

= Bit Depth

= Sample Rate

= Flows

= QoS

= |GMP Snooping

= VLANS, LAGs & STP

= Switches & Cables
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Dante: Bit Depth
= Dante devices can work at 16-bit, 24-bit or 32-bit.

= Others can only work at 24-bit.

& R 5 du 'Y001-Yamaha-CL5-060ba6 e (?)

' Receive Transmit  Status - Device Config | Network Config)

-Rename Device

Y001-Yamaha-CL5-060ba6

-Sample Rate

Sample Rate: | 48k e ] Pull-up/down: | NONE  |% ]

-Encoding

[ Encoding: | 24 = ] ]
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Dante: Bit Depth

" These different bit depths can co-exist on the
network.
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Dante Bit Depth

f a 24-bit device transmits to a 32-bit device, 8 “zero
nits” are added to each word.

= |f a 32-bit device transmits to a 24-bit device, the last
8 bits are simply removed.
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Dante: Advanced

= Contents:
= Clock
= |Latency
= Bit Depth
= Sample Rate
= QoS
= |GMP Snooping
= VLANS, LAGs & STP
= Switches & Cables
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Dante: Sample Rate
= Different sample rates can co-exist on the same
Dante network.

= Even 44.1kHz and 48kHz can share the network.
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Dante: Sample Rate
= But devices working at different sample rates cannot
share audio!

= Dante Controller doesn’t let you make the patch if the
sample rates do not match.
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Dante: Advanced
= Contents:

= Clock

= |Latency

= Bit Depth

= Sample Rate

= Flows

= QoS

= |GMP Snooping

= VLANS, LAGs & STP

= Switches & Cables
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Dante: Flows
= For efficiency, Dante organises audio channels into
groups, or “flows” whenever possible.

= Up to 4 channels are grouped in each “Flow” when
they are transmitted and received by the same
devices (unicast traffic).
= |t means they share the same Ethernet data packets.

= This is efficient for bandwidth.

““““““

{fmiminimiminim i o | o PRESISISESESISY) T | L s | D,

(S nae e § 32 Channels
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Dante: Flows
= Dante Controller shows the number of Flows
= Device View->Transmit

& R o oo _Y001-Yamaha-Ri03224-D-0606ea '+!  (2)

[Receive Transmit  Status = Device Config = Network Configj

Transmit Channels Transmit Flows
Channel Signal Channel Label f Unicast: 8
01 LD Er Multicast: 0 ]
02 Total: 8 of 32
04 L |
05
06
07 of)

32 Channels

e | ERTRECTRC e .
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Dante: Flows
= Note the maximum number of Flows:
= 32 Flows for all Brooklyn Il based devices

o ' YOO1-Yamaha-Rio3224-D-0606ea '+ |

Receive ~ Transmit | Status Device Config = Network Configj mit  Status = Device Config  Network Config |

on

Transmit Channels Transmit Flows

- ' & Manufacturer: Yamaha Corporation
Signal Channel Label Unicast: 32 Product Type: Rio3224-D
" 3 roduct Version: 1.50.0
o) Ar

Multicast: 0 ftware Version: 1.1.0
Total: 32 of 32 mware Version: 1.1.0

|

‘

i

‘ quelf Brooklyn Il
Software Version: 3.6.4.20

: Firmware Version: 3.4.3.8

‘

|

sation

Mute Status: Unmuted
Sync Status: Locked
External Word Clock: No
Preferred: No
Frequency Offset: -52 ppb

AAasasa

rPrimary Interface

IP Address: 169.254.169.203
MAC Address: 00:1D:C1:06:06:EA

Tx Utilisation: 316 Mbps Errors: 0
Rx Utilisation: 59 Mbps  Errors: O
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Dante: Flows

= With 32 Flows, you can:
= Transmit up to 4 channels to 32 different devices
= Transmit up to 8 channels to 16 different devices
= Transmit up to 16 channels to 8 different devices
= Transmit up to 32 channels to 4 different devices

& R 9 Do ' YOO01-Yamaha-Rio3224-D-0606ea '+

' Receive - Transmit = Status  Device Config = Network Config]

Transmit Channels Transmit Flows

Channel Signal Channel Label Unicast: 32

01 L 2 ar Multicast: 0

02 Total: 32 of 32
03
04
05
06
07
08

A A A A A A A
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Dante: Flows

= So a Brooklyn Il device can do a “digital split” to 4
consoles / multi-track recorders

32 Channels x4



@audinate .
Dante: Flows (Unicast / Multicast)

= Need to “digital split” to more devices?
= Use “Multicast”!
= By default, all Dante Flows are “Unicast”

" This preserves network switch bandwidth.
= Unicast only goes to the designated devices
" Multicast transmits to all Dante devices in the network!

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: Flows - Multicast
* When do you need to use “Multicast”?

= When transmitting 2 channels to many amps
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Dante: Flows - Multicast
= Use “Multicast”;

= When transmitting 32 channels from Rio3224-D to 5
devices (3 consoles + 2 PCs for example)
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Dante: Flows - Multicast
= Use “Multicast”

= When playing from Dante Virtual Soundcard to 2 or more
consoles.

= DVS only has 16 Flows (16x4 = 64 Channels)

= So to transmit 64 channels to 2 consoles, Multicast is
required.
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Dante: Flows - Multicast Vs. Unicast
= Multi- Unicast is more work for the transmitting
device: it sends several copies of the same data.

"= Multicast is more work for the switches: it copies &
sends the data to all Dante devices in the network!

Unicast x4
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Dante Controller & Multicast

= Dante Controller gives tips for when Multicast could
be necessary.

= Look in the “Events” page after routing one Transmitter to
3 or more Receivers:

800 Dante Controller - Network View
File Device Help

& SHE a0 Master Clock: Y001-Yamaha-CL5-060ba6 Multicast Ban{idth: 3Mbps | ('_I)

| Routing = Device Status = Clock Status m

Severity  Timestamp Description

Fanout configuration detected:
Device Y001-Yamaha-Rio3224-D-0606ea has 4 channels transmitting via unicast to 3 or more receivers.
Unicast transmission to multiple receivers results in higher transmit flow usage.
Jun 28 2013 11:03:02 Add these channels to multicast flows to reduce transmit flow usage.
Note that multicast flows should be used carefully.
It is possible to exceed the multicast handling capability of some Ethernet switches.
Unless your network has been properly configured, try to keep total multicast audio traffic below 100Mbps.
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Dante Controller & Multicast

= Dante Controller is needed to create “Multicast”
Flows
= Multicast Flows can hold up to 8 channels each.

= Click on the Golden “Split” icon in Device View->Transmit
tab.

& R ® >u ' casc-machook BENO

(Create a new multicast flowtus =~ Device Config = Network Config }

Transmit Channels Transmit Flows
Signal  Channel Label Unicast: 0
Multicast: 4
Total: 4 of 16

Multicast Flow 1: 05,06,07,08
Multicast Flow 2: 09,10,11,12
Multicast Flow 3: 13,14,15,16
Multicast Flow 5: 01,02,03,04

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante Controller & Multicast
= Don’t create Multicast Flows that are not needed.
= Preserve the network bandwidth.

= Remember Multicast is transmitted to ALL networked

devices...
* Unless IGMP Snooping, or multicast filtering is turned on

& 0 e casc-machook 0
"Te‘ Create a new multicast flowtus =~ Device Config =~ Network Config }
Transmit Channels Transmit Flows
Channel Signal  Channel Label Unicast: 0
01 Multicast: 4
02 Total: 4 of 16
03 Multicast Flow 1: 05,06,07,08
04 Multicast Flow 2: 09,10,11,12
05 Multicast Flow 3: 13,14,15,16
06 Multicast Flow 5: 01,02,03,04
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Dante: Advanced
= Contents:

= Clock

= |Latency

= Bit Depth

= Sample Rate

" Flows

= QoS

= |GMP Snooping

= VLANS, LAGs & STP

= Switches & Cables

http://www.audinate.com/resources © 2015 Audinate, Inc. 48




audinate

Dante: QoS
= QoS = Quality of Service
" |tis traffic management

* Fast lanes, cycle lanes, bus lanes, emergency vehicle lanes...
* Different types of traffic have different priorities.

* There are several different methods for optimizing traffic flow

= Dante uses DiffServ

= Differentiated Services Code Point
= Also known as DSCP
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Dante: QoS
= DSCP has 64 different types of data to prioritize

= Dante uses just 4 of them

* #56 is given to the PTP data (word clock timing)
— Needs Highest priority

* #46 is given to audio data - Clock
— Needs High priority

e #8 is given to other Dante data,
such as control & monitoring

— Needs Medium priority

e All other values have low
priority.
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Dante: QoS - when to use

= QoS is only needed when networks get congested
= For example, with a lot of multicast traffic
= Or when mixing Dante with a lot of other data
= Or when 100MB equipment is used

" |tis not needed on small system for example.

= As your network grows, it is best to be prepared in
advance:

* The consequences could be audio dropouts!
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e

cisco SG300-20 20-Port Gigabit Managed Switch

Getting Started
—ememesanis | PSP Qe Control Clock
» Administration DSCP to Queue Table 0
» Port Management Ingress DSCP | Output Queue | Inggg€s DSCP | Output Queue | Ingress DSCP utput Queue | Ingress DSCP | OutputfBueue
» Smartport 0 (BE) 1 (CS2) 1 - 32 (CS4) v 48 (CS6) 1
» VLAN Management 1 1 v 17 1 v 33 v 49 1
> Spanning Tree 2 1 v 18 (AF21) 1~ 34 (AF41) v 50 -
» MAC Address Tables : g 19 1 - 15 - 51 -
- ;
Mullicaalk 4 1 20 (AF22) 1~ 36 (AF42) - 52 1 v
» |P Configuration
Securily 5 v 21 1~ 37 v 53 1 v
» Securi
6 1~ 22 (AF23) 1~ 38 (AF43) v 54 1~
» Access Control
7 1 23 1~ 39 v 55 1
— | 8 (CS1) 2 - 24 (CS3) 1 40 (CS5) v 2(037) 4 -
QoS Properties 9 1~ 25 1 41 - 57 1 v
Queue 10 (AF11) 1~ 26 (AF31) 1~ 42 v 58 1~
.CoSISOZ.1ptoQueue 1 1 v 27 1 v 43 1 59 1~
“Bandwidth ue 12 (AF12) 1~ 28 (AF32) 1~ 44 1 v 60 1>
Egress Shaping Per Queue| | > 1~ = - s o il 1'
VLAN Ingress Rate Limit 14 (AF13) 1~ 30 (AF33) 1~ |46 (EF) 3~ 62 1~
TCP Congestion Avoidance| | 15 1 v 31 1 v 1 v 63 1~
» QoS Basic Mode ( )
i lewhpplyss] | Cancel | |  Restore Defaults |
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€« c ] 192.168.1.254/home.htm

- D0-20 20-F0 gab s C
Getting Staned n
Tseusassama | D5CPoQueee  Control Audio Clock
» Administration DSCP to Queue Table
» Port Management Ingress DSCP  Output Queue | Ingrgs DSCP  Output Queue | Ingress DSCP | Dutput Queue  Ingress DSCP  Output @lieue
» VLAN Management 0 (BE) 1 s (CS2) (2 2] 32(CS4) W
» Spanning Tree 1 - 17 2 33 3
» MAC Address Tables 2 LSy 18 (AF21) | 2 34 (AF41) 3
» Multicast 3 - 19 y B 35 3
» IP Configuration 4 1 20 (AF22) | 2 36 (AF42) 3
» Secunty 5 7 21 2o 37 3
v GQuakty of 8 - 22 (AF23) | 2 38 (AF43) 3
+ General 7 1 23 durd 39 3
QoS Properties 8(CS1) e 24 (CS3) (3 : 40 (CS5) 4
Interface Setings 0 1 - 25 3 3 41 4 57 3 3
Queue
CoS/802.1p 10 Queue 10 (AF11) 1 s 26 (AF31) (3 2] 42 4 58 3 :
DSCP to Queue’ 1 - 27 3 43 B 59 3 :
12 (AF12) sy 28 (AF32) [ Bunis 4 60 R
Egress Shaping Per Queue 13 - 29 (3 61 N
» QoS Statistics
14 (AF13) w 0(AF33) (3 : |:| 62 3.3
15 - 31 3 47 4 63 3
\ewhpplysl | Cancel | |  RestoreDefaults |
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Dante: Advanced

= Contents:
= Clock
= |Latency
= Bit Depth
= Sample Rate
= Flows
= QoS
= |GMP Snooping
= VLANS, LAGs & STP
= Switches & Cables

http://www.audinate.com/resources © 2015 Audinate, Inc. 54




audinate

Dante: IGMP Snooping

= What is IGMP Snooping?
" |Internet Group Membership Protocol
" |t is multicast data management

" |t can restrict the propagation of
multicast traffic.

= When is IGMP Snooping needed?

= When lots of Dante Multicast flows
are used

= When Dante is mixed with other
types of Multicast traffic.
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Dante: IGMP Snooping
= How does it work?
= Each flow of multicast data is assigned an IP address
= The switch will take a note of all the multicast IP addresses

= |f a device needs to receive the multicast data, it will ask
the switch to forward it.

= The switch will only forward the multicast data to the
devices that request it.

= So it can greatly reduce the
amount of multicast traffic

in a hetwork!
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Dante: IGMP Snooping
= An example, when doing a Virtual Sound check:

= To playback from Dante Virtual Soundcard to 2 consoles,
Multicast is needed.

= Normally, this traffic will spread all over the Dante
network.
* The stageboxes don’t need it, but they will still receive it!
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Dante: IGMP Snooping
= An example, when doing a Virtual Soundcheck:

= With IGMP Snooping enabled, the switches will check the
Multicast data.

= So it only reaches the Mixers.

* The Dante audio data will only transmit to the devices that are set
to receive in the Dante patch/routing grid.

IGMP

~Snooping
V
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Dante: IGMP Snooping
" The effect on bandwidth

= With Snooping disabled,
stagebox receives 181 Mbps

= With Snooping enabled,
stagebox receives 68Mbps

* This is just the 24 outputs
from the Console.

PRLLILERF -,

A2

ttp://www.audinate.com/resources © 2015 Audinate, Inc.

rPrimary Interface

IP Address: 169.254.169.203
MAC Address: 00:1D:C1:06:06:EA
Tx Utilisation: 44 Kbps  Errors: 0
Rx Utilisation: 181 Mbps Errors: 0

IP Address: 169.254.169.203
MAC Address: 00:1D:C1:06:06:EA
Tx Utilisation: 38 Kbps  Errors: 0
Rx Utilisation: 68 Mbps  Errors: 0

—
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Dante: IGMP Snooping
= This is vital when:

= Using Multicast Dante in 100M networks
e Bandwidth can quickly be filled
= Using critical control devices on

the same network as Multicast
Dante traffic

* Where control and audio use the same network port on the device

= Using Wi-Fi on the same network as Dante

* Otherwise Dante multicast data will flood
the wi-fi bandwidth.

=N
2
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Dante: IGMP Snooping
= How tosetitup
= Using Cisco SG300-20

= This switch has IGMP Snooping
* V3 is the latest version, which is
ideal for use with Dante
= This feature is rare to
find on such low cost
switches!

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: IGMP Snooping
= How tosetitup

= Open the Multicast menu

= Enable Multicast

Small Business
il

cisco  SG300-20 20-Port Gigabit Managed Switch

Getting Started

Filtering

= For each VLAN,

select “IP Group
Address” as the
Forwarding Method.

http://www.audinate.com/resources © 2015 Audinate, Inc.

» Status and Statistics

Properties

» Administration

» Port Management

Bridge Multicast Filtering Status: v Enable ]

» Smartport

» VLAN Management

» Spanning Tree

» MAC Address Tables

........................

Properties

MAC Group Address

IP Multicast Group Address
IGMP Snooping

MLD Snooping

IGMP/MLD IP Multicast Group
Multicast Router Port
Forward All

Unregistered Multicast

» IP Configuration

> Security

» Access Control

» Quality of Service

> SNMP

VLAN ID: 1~

Forwarding Method for IPvG:

i VIR UUR AUUTE
(¢ |P Group Address

Forwarding Method for IPv4: " MAC Group Address

(¢ |P Group Address

HpH [ Cancel
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Dante: IGMP Snooping

= How tosetitup
= Open the IGMP Snooping menu

" Enable Snooping
= Edit each VLAN setting...

Small Business
e

cisco SG300-20 20-Port Gigabit Managed Switch

Getting Started
Status and Statistics

bdminiaiaiion IGMP Snooping Status: [+ Enable
Port Management

Smartport M_J [ Ganaak |
VLAN Management
Spanning Tree IGMP Snooping Table

MAC Address Tables Entry No. = VLAN ID IGMP Snooping Router MRouter Ports Query Query = QueryMaxResponse LastMember LastMember Query Immediate = IGMP Querier = IGMP Querier = Querier
Operational Status | IGMP Version Auto Learn Robustness | Interval (sec.) Interval (sec.) Query Counter Interval (mSec.) Leave Status Version IP Address
Properties { Enabled V3 Enabled 2 30 10 2 1000 Disabled Enabled V3

MAC Group Address ( Enabled 3 Enabled 2 30 10 2 1000 Disabled Enabled 3

IEhulticas ENONBIAdCIRES C Enabled ) Enabled 2 30 10 2 1000 Disabled  Enabled 3
AMLD Snooping Copy Settings Edit
IGMP/MLD IP Multicast Group
Multicast Router Port

Forward All
Unregistered Multicast
IP Configuration
Security
Access Control
Quality of Service
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Dante: IGMP Snooping
= How tosetitup
= Enable Snooping Status & Querier Status

= Set Query Interval to minimum value: 30
= Check IGMPV3

IGMP Snooping Status:

v Enable

_

MRouter Ports Auto Learn:

v Enable

1-7, Default: 2

Query Interval:

# Query MaxResponse Interval:

% LastMember Query Counter:

% LastMember Query Interval:

Immediate leave:

|30 j sec. (Range: 30 - 18000, Default: 125
|10 sec. (Range: 5 - 20, Default: 10
® Use Default

User Defined Range: 1-7, Defa
|1000 mS (Range: 100 - 25500, Default: 1000
[~ Enable

IGMP Querier Status:

Enable

~ UserDefined 192.168.0212 ~

[IGMP Querier Version:

~IGMPV2
@« IGMPV3

Operational IGMP Snooping Status:

Operational Query Robustness:
Operational Query Interval:

Operational Query Max Response Interval:

Operational Last Member Query Counter:

Operational Last Member Query Interval:

Operational Querier Source IP Address:

Enabled

2
30 (sec)

10 (sec.)

2

1000 (mS)

192.168.0.212
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Dante: IGMP Snooping
= Be aware that some other
types of switch do not I Gigabit Managed Switch

“" ” Getting Started .
have the correct “Query comsis | o\ Group Acress
. N » Administration The Bridge Multicast Filtering is currently enabled.
For IP Multicast Configuration to be effective, the Bridge Multicast Filtering mustk
functions to work alone in |} s
» Smartport IP Multicast Group Address Table
k » VLAN Management Fiter [~ VLA} l—
a Da nte networ . » Spanning Tree '
» MAC Address Tables - ‘
1P Ml
= The SG300 has all
MAC Group Address r l
n e C e S S a ry IP Multicast :_fg?:i;‘l_‘-\;eéﬁlﬁi‘]?.ﬁiii wa Source IP Address
IGMP Snooping r 1 22401129 N
. MLD Snooping .
fu nctions IGMPIMLD IP Multicast Group = 1 202464t
) Mulicast Router Port L 123025627101
. . Forward Al In 1 23025588176
"= Hereis a switch Unregistered Muticast -1 1 mezssim85
> IP Configuration In 1 23925514375
t h at h as f oun d » Security r 1 239.255.145246
o T In 1 239.255.149.138
4 hdGtialityOkSaica r 1 23925515086
and filtered several I IRl
hd [ 1 239.255.255.250 z
multicast flows. e
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DVS with IGMP Snooping

"= There is one potential problem when using DVS &
IGMP Snooping
= Some computers don’t handle it so well
= This will result in silence from DVS!

" |In that case, use the e
cisco SG300-20 20-Port Gigabit Managed Switch
“Forward All” setting f ;
orwar setting for
. : Poﬂ; : : Succe: To permanently save the connguratlon, go to the Copy'Save Config
p O rtS u S e d W I t h DVS ® : i“":mn Filter: VLANID equalsto 1 ~ AND /Interface Type equalsto Port ~ E
: o & Port GE1 Gl GE3 GE4 GE5 GE6 G GFS E9 A10 GA

= Use this with care, and only
when it is essential

= |t allows all Multicast data A
through the port! —

66
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Dante: Advanced
= Contents:

" Clock

= |atency

= Bit Depth

= Sample Rate

" Flows

= QoS

= |[GMP Snooping

= VLANS, LAGs & STP

= Switches & Cables

http://www.audinate.com/resources © 2015 Audinate, Inc. 67
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Dante: VLANS
= VLAN:

= \irtual Local Area Network

= Sometimes, VLANs can be used to separate a
network into segments

= Each segment would carry data for different
purposes.

= Such as audio / lighting / control /
internet access, etc.

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: VLANS

= Sometimes, VLANs can be used to
separate an audio system into segments

= Each segment would have a different person
managing it.

= This might be needed in large touring systemes.




audinate

Dante: VLANSs

= For example:
= 1 VLAN for the support band’s stage boxes & consoles
= 1 VLAN for the main band’s stage boxes & consoles
= 1 VLAN for the speaker processing & amp distribution.

= Use a device like DME, or Auvitran’s Audio Toolbox
to bridge between the VLANSs.

http://www.audinate.com/resources © 2015 Audinate, Inc. 70
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Example
2 ]
VLAN-3 f
-3 for
Ve ich Processor
Support s & Amps
VLAN-1 for ' Band system
Main Band ==
system
ALL VLANSs
share the
long
“Multicore”

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: LAGs
= LAG = Link Aggregation Group

= Sometimes called “Trunk”

= When 2 or more cables are used to carry the data between
2 switches.

= This can increase available bandwidth to 2GB
= Or it can be used as a form of cable redundancy.

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: LAGS

= When one cable breaks, there can be a short silence
= Less than 0.5sec

= Butitis alow cost and simple way to get “Multicore”
cable redundancy

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: STP

= STP = Spanning Tree Protocol
= |tis a form of network redundancy

= |t allows loops to be formed in networks

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante & STP

= When one cable breaks, there can be silence up to 2
seconds.

= When the cable is repaired again, there can be
longer silences of up to 20 seconds!

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: STP

= STP and Dante are compatible, but STP is not as
quick as Dante’s own Primary/Secondary dual
network redundancy.
= Glitch-free Redundancy!

= So, only use STP when it is necessary to protect other
data sharing the network.

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: Advanced
= Contents:

= Clock

= |Latency

= Bit Depth

= Sample Rate

" Flows

= QoS

= |GMP Snooping

= VLANS, LAGs & STP

= Switches & Cables

http://www.audinate.com/resources © 2015 Audinate, Inc. 77
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Dante: Cables
= Dante is 1Gb, while CobraNet, EtherSound, and
many other formats are 100Mb

= Use shielded cable when RF interference is possible
= Also better protection against EMI interference

= Un-shielded will work in most cases
* Un-shielded is easier to install & terminate!

http://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: Cables - CAT5/6/7
= What's the difference between CAT5, 6 & 77
= CATS is the original standard, for 10Mb & 100Mb networks
= CAT5e is an enhanced standard, suitable for 1Gb

= CAT6 has more twists per metre, and a separator between
each pair, designed for 1Gb networks

= CAT7 has an individual shield for each pair, designed for
10Gb networks

ttp://www.audinate.com/resources © 2015 Audinate, Inc.
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Dante: Cables - CAT5/6/7

= Which one to use?
= Don’t use the old standard of CAT5
* (rare to find new)

= Use CAT5e or CATSH, solid core, shielded

= CAT7 can be used for all devices, but is less easy to work
with: termination takes more time, it is stiffer, and more

expensive
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Dante: Cables - max length
= Never use a copper cable longer than 100m
= Use cable with solid copper cores whenever possible

= Stranded copper cores are more
flexible, but not so good at long
distance transmission

* Keep 60m maximum with stranded
cable

* Alot of rugged “stage-cable” is
stranded, so take care.
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Dante: Cables - Fibre-Optic
"= There are 2 main types:

= Multi-Mode, up to about 500m

= Single-Mode, good for several Km!

= Either can be used, with the correct interface

= Multi-mode is lower cost

= Single-mode can go
longer distance and have
more joins (like for patch
panels)
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Dante: Cable - Fibre-Optic Converters

= A converter is needed to change from CAT5e or CAT6
to fibre
= Use a switch that has fibre modules included

= They can be easier to trouble-shoot than stand-alone
converters

= Use the same type of fibre module at each end

= Use a patch panel to hold
rugged fibre connections.
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Dante: Ethernet Switches
= There are so many types

= What are the necessary features?
= 1GB (or more) for every port

= Switching capacity equal to 2 x number of ports (eg,
20Gbps for a 10 port switch)
* This can be tough to determine accurately
= |f it has EEE (Energy Efficient Ethernet), then it should be
disabled

* If the switch has this feature and is un-managed, then it can’t be
disabled: avoid it!

84
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Dante: Ethernet Switches
= “Nice to have” features:
= |nternal power supply
= Silent (or no) cooling fan
= Rack-mount kit
= Fibre option modules
= Easy to use web interface for programming
= Error reporting & trouble-shooting tools.
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Dante: Advanced
= Contents:

= Clock

= |atency
L Questions?
= Sample 'Rate

= Flows

= QoS

= |GMP Snooping

= VLANS, LAGs & STP
= Switches & Cables

http://www.audinate.com/resources © 2015 Audinate, Inc.
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